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About This Guide

This Novell ZENworks 11 SP2 Configuration Management Policy Management Reference includes
information about Policy Management features and procedures to help you configure and maintain
your Novell ZENworks 11 SP2 Configuration Management system.

For information on policies that control a range of security-related functionalities for Windows
devices or help protect and configure the ZENworks Endpoint Security Agent, see the ZENworks 11
SP2 Endpoint Security Policies Reference.

The information in this guide is organized as follows:

¢ Chapter 1, “Overview,” on page 9

¢ Chapter 2, “Creating Linux Configuration Policies,” on page 13

¢ Chapter 3, “Creating Windows Configuration Policies,” on page 19
¢ Chapter 4, “Managing Policies,” on page 51

¢ Chapter 5, “Managing Policy Groups,” on page 81

¢ Chapter 6, “Managing Folders,” on page 85

¢ Appendix A, “Troubleshooting Policy Management,” on page 87

¢ Appendix B, “Best Practices,” on page 121

¢ Appendix C, “iPrint Policy Management Utility,” on page 123

¢ Appendix D, “Documentation Updates,” on page 133

Audience

This guide is intended for Novell ZENworks administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comments feature at the bottom of each page of the
online documentation.

Additional Documentation

ZENworks Configuration Management is supported by other documentation (in both PDF and
HTML formats) that you can use to learn about and implement the product. For additional
documentation, see the ZENworks 11 SP2 documentation Web site (http://www.novell.com/
documentation/zenworks11).

About This Guide
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1.1

1.2

Overview

Novell ZENworks 11 SP2 Configuration Management provides policies to configure operating
system settings and select application settings. By applying a policy to multiple devices, you can
ensure that all of the devices have the same configuration.

The following sections contain additional information:

¢ Section 1.1, “What Is a Policy?,” on page 9

¢ Section 1.2, “What Is a Policy Group?,” on page 9

¢ Section 1.3, “Understanding the Policy Types,” on page 10

¢ Section 1.4, “Understanding the Features of a Policy,” on page 11

What Is a Policy?

A policy is a rule that controls a range of hardware and software configuration settings on the
managed devices. For example, an administrator can create policies to control browser bookmarks
available in the browser, printers to access, and security and system configuration settings on the
managed devices.

You can use the policies to create a set of configurations that can be assigned to any number of
managed devices. It helps you to provide the devices with a uniform configuration, and it eliminates
the need to configure each device separately.

You can assign a policy directly to a device or a user. You can also assign the policy to a folder or
group where the user or device is a member. Assigning a policy to device groups rather than device
folders is the preferred way, because a device can be a member of multiple device groups, but it can
be a member of only one device folder.

On managed devices, each policy type is enforced by a Policy Handler or Enforcer, which makes all
the configuration changes necessary to enforce or unenforce the settings in a given policy.

What Is a Policy Group?

A policy group is a collection of one or more policies. Creating policy groups eases the
administration efforts in managing policies. You can create policy groups and assign them to
managed devices the same way you would assign individual policies.

Because the policy inherits the group’s assignments, managing a policy group is easier than
managing individual policies. For example, if multiple policies are included in a policy group and the
policy group is assigned to a device or a device group, then all the policies included in the policy
group are automatically assigned to the device or device group at the same time. You need not
individually assign each policy to a device or a device group.

Overview
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1.3 Understanding the Policy Types

ZENworks 11 SP2 lets you create the following policy types:

¢ Linux Configuration Policies: Lets you configure policies supplied by ZENworks
Configuration Management that are used to manage configuration settings for Linux devices.
The following policies are located in this category:

¢ External Services policy
¢ Puppet policy

+ Windows Configuration Policies: Lets you configure policies supplied by ZENworks
Configuration Management that are used to manage configuration settings for Windows
devices. The following policies are located in this category:

¢ Browser Bookmarks policy

¢ Dynamic Local User policy

¢ Local File Rights policy

¢ Power Management policy

¢ Printer policy

¢ Remote Management policy

¢ Roaming Profile policy

¢ SNMP policy

+ Windows Group policy

¢ ZENworks Explorer Configuration policy

¢+ Windows Endpoint Security Policies: Lets you configure policies supplied by ZENworks
Endpoint Security Management that are used to manage security settings for Windows devices.
The following policies are located in this category:

¢ Application Control policy

¢ Communication Hardware policy
¢ Data Encryption policy

¢ Firewall policy

¢ Location Assignment policy

¢ Scripting policy

¢ Security Settings policy

¢ Storage Device Control policy
¢ USB Connectivity policy

¢ VPN Enforcement policy

¢ Wireless policy

The Windows Endpoint Security policies are not covered in this guide. For information about
these policies, see the ZENworks 11 SP2 Endpoint Security Policies Reference.

¢ Windows Full Disk Encryption Policies: Lets you configure policies supplied by ZENworks
Full Disk Encryption that are used to encrypt entire disks (or volumes) for Windows devices.
The following policy is located in this category:

¢ Full Disk Encryption policy

The Windows Full Disk Encryption policies are not covered in this guide. For information about
these policies, see the ZENworks 11 SP2 Full Disk Encryption Policy Reference.
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1.4 Understanding the Features of a Policy

¢ A policy is applied to a device or a user only if the policy is directly or indirectly associated to
that device or user.

The Browser Bookmarks policy, Dynamic Local User policy, Printer policy, Remote Management
policy, Windows Group policy, and ZENworks Explorer Configuration policy can be applied to
a device or a user:

The Local File Rights and SNMP policies can be applied only to a device.

The Roaming Profile policy can be applied only to a user.
¢ A policy can be associated to groups and containers.

In ZENworks Control Center, devices and users can be organized by using containers and
groups. A device or user can be a member of multiple groups. The containers can be nested
within other containers. If a policy is associated to a group of users, it applies to all users in that
group. If a policy is associated to a user container, it applies to all users in the entire subtree
rooted at that container. The same behavior applies to device groups and containers.

¢ A policy can be associated to query groups.

In ZENworks Control Center, the devices can also be members of query groups. Query groups
are similar to ordinary groups except that the membership is determined by a query defined by
the administrator. All devices that satisfy the query become members of that device group. The
query is evaluated periodically and the membership is updated with the results. An
administrator can configure the periodicity of the evaluation. An administrator can also force an
immediate refresh of a query group. Query groups act just like other groups where policies are
concerned.

¢ Policies are chronologically ordered by default.

When multiple policies are associated to a device, user, group, or container, the associations are
chronologically ordered by default. The administrator can change the ordering.

If a device or user belongs to multiple groups, the groups are ordered. Consequently, the policies
associated to those groups are also ordered. The administrator can change the ordering of
groups for a device or user at any time.

In addition, the policies in a policy group are ordered.

¢ Policies have a precedence configured to determine the policy that is effective for a device or a
user.

Many policies of the same type can be applied to a user or a device through direct association
and inheritance. For example, if a Browser Bookmark policy is associated to a user and another
Browser Bookmark policy is associated to a container containing that user, the policy directly
associated to that user overrides the policy associated to the container.

¢ Policies support management by exception.

You can define a global policy for your enterprise and associate it to the top-level container
containing all your user objects. You can then override configuration items in the global policy
by defining a new policy and associating it to specific users or user groups. These users receive
their configuration from the new policy. All other users receive their configuration from the
global policy.

¢ Policies support system requirements.

You can specify the system requirements of a device or user in a policy. The policy is applied to a
device or user only if the device or user meets the system requirements.

For example, the SNMP policy is applied by default on all devices having the SNMP service
installed.

Overview 11



¢+ ZENworks Configuration Management supports singular and plural policies.

Singular Policy: If multiple policies of the same policy type are assigned to a device or a user
and the policy type is a Singular policy, then only the nearest associated policy meeting the
system requirements is applied. If the policy type is associated to both user and device, then two
different policies can be assigned to user and device.

The SNMP policy, Dynamic Local User policy, Remote Management policy, Roaming Profile
policy, Power Management policy, and ZENworks Explorer Configuration policy are singular
policies.

Plural Policy: If multiple policies of the same policy type are assigned to a device or a user and
the policy type is a Plural type, then all policies meeting the associated system requirement are
applied.

The Browser Bookmarks policy, Local File Rights policy, Windows Group policy, and Printer
policy are plural policies. However, the security settings in the Windows Group policy are not
plural.

+ Policies can be disabled.

When you create a policy in ZENworks Configuration Management, the policy is enabled by
default. You can disable it if you do not want to apply it on a user or a device.

¢ ZENworks Configuration Management allows you to resolve policy conflicts.

The set of effective policies is a subset of the set of assigned policies. The set of effective policies
for a device or user is calculated by applying precedence rules, multiplicity rules, and system
requirements filters on the set of assigned policies. Effective policies are calculated separately for
devices and users. The Policy Conflict Resolution setting determines how user and device
policies interact for a specific user and device combination.

Effective policies are calculated separately for devices and users. When a user logs in to a device,
policies associated to both the user and the device must be applied. Policy Conflict Resolution
settings are used only when policies of the same type are associated to both the device and the
user. This setting determines the precedence order among the policies associated to the user and
those associated to the device. The Policy Conflict Resolution settings are applied after the
effective policies are calculated.

Policy Conflict Resolution settings are defined when associating a policy to a device. The
settings cannot be defined for associations to users. For each policy type, the Policy Conflict
Resolution setting defined in the closest effective policy of that type is applied for all policies of
that type.

A Policy Resolution Conflict setting can have one of the following values:

¢ User Last: Applies the policies associated to the device first, then the policies associated to
the user. This is the default value.

¢ Device Last: Applies the policies associated to the user first, then the policies associated to
the device.

¢ User Only: Applies only the policies associated to the user and ignores the policies
associated to the device.

¢ Device Only: Applies only the policies associated to the device and ignore the policies
associated to the user.

NOTE: The Policy Conflict Resolution setting is taken from the device-associated policy with the
highest precedence.

¢ When a user manually logs out of Z-Icon login and logs in as a different ZENworks user, the
Roaming Profile policy, Dynamic Local User policy, and Group policy will not be applied.
However, ZENworks Configuration Management will enforce these policies at the next general
refresh and the user will be prompted for a re-login if required.

12 ZENworks 11 Configuration Policies Reference



2.1

Creating Linux Configuration Policies

Novell ZENworks 11 SP2 Configuration Management lets you create policies by using ZENworks
Control Center or by using the zman command line utility.

The following sections contain step-by-step instructions about creating the Linux configuration
policies by using ZENworks Control Center.
¢ Section 2.1, “External Services Policy,” on page 13

¢ Section 2.2, “Puppet Policy,” on page 15

External Services Policy

The External Services policy lets you configure the external services on a Linux managed device for
YUM, ZYPP or MOUNT repositories. It enables you to download and install the software packages
or updates from these repositories on the managed devices.
1 In ZENworks Control Center, click the Policies tab.
2 In the Policies list, click New, then click Policy.
or
In the Policy Tasks, click New Policy.
The Select Platform page is displayed.
3 Select Linux, then click Next.
The Select Policy Category page is displayed.
4 Select Linux Configuration Policies, then click Next.
5 Select External Services Policy as the Policy Type, then click Next.
6 In the Define Details page fill in the following fields:

Policy Name: Provide a name for the policy. The policy name must be different from the name
of any other item (group, folder, and so forth) that resides in the same folder. The name you
provide displays in ZENworks Control Center.

Folder: Type the name or browse to and select the ZENworks Control Center folder where you
want the policy to reside. The defaultis /Policies, but you can create additional folders to
organize your policies.

Administrator Notes: Provide a short description of the policy’s content. This description
displays in ZENworks Control Center.

7 Click Next to display the External Services Policy page.
8 In the External Services Policy page, click Add to display the External Services Policy dialog box.

9 The following table lists the tasks you can perform in the External Services policy dialog box.

Creating Linux Configuration Policies
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Task Steps Additional Details
Add an External 1. Click Add to display the External Services The available repository types
Service Policy dialog box. are AUTO, ZYPP, YUM, and

2. Specify the name of the service, the URL
for the service, and the type of repository
to which you want to add the service. Click
Help for information on how to fill the
required fields.

3. Select the checkbox Recursive to add
services on the managed device for the
Romps present under all the
subdirectories of the specified URL. The
recursive property is applicable only to the
MOUNT service type.

4. For External Services that require

authentication, click |4 to browse to and
select an existing credential from the
Credential Vault.

5. Select the check box Synchronize with
External Package Management Tools, to
synchronizes the External Services with
the package management tools.

6. Click OK.
Edit an External 1. Select the External Service you want to
Service edit, then click Edit.

2. Follow the online prompts to make

changes.
3. Click OK.
Remove an External 1. Select one or more External Services that
Service you want to remove, then click Remove.

MOUNT.

AUTO is a default repository
type, if selected, the system
automatically detects either

ZYPP or YUM as the type of
repository.

The credential option is not
applicable to the MOUNT
service type.

The service name and recursive
property once specified cannot
be edited. To edit these options
for the existing service, remove
the service and add a new
External Service.

10 Review the information on the Summary page and, if necessary, use the Back button to make

changes to the information on the Summary page.

11 (Conditional) Select Create as Sandbox, if you want to create the sandbox version of the policy.

12 Select the check box for Define Additional Properties.

13 Click Finish to create the new External Services policy.

14 Click Relationships and assign the newly created External Services policy to a test device and a

non-test device.

NOTE

If you disable the Bundle Management module, services that are a part of the External Services

policy do not flow down to the agent.
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2.2 Puppet Policy

The Puppet policy lets you apply the Linux configuration on the Linux devices.

1 In ZENworks Control Center, click the Policies tab.
2 In the Policies list, click New, then click Policy.
or
In the Policy Tasks, click New Policy.
The Select Platform page is displayed.
3 Select Linux, then click Next.
The Select Policy Category page is displayed.
4 Select Linux Configuration Policies, then click Next.
5 Select Puppet Policy as the Policy Type, then click Next.
6 In the Define Details page fill in the following fields:

Policy Name: Provide a name for the policy. The policy name must be different from the name
of any other item (group, folder, and so forth) that resides in the same folder. The name you
provide displays in ZENworks Control Center.

Folder: Type the name or browse for and select the ZENworks Control Center folder where you
want the policy to reside. The defaultis /Policies, but you can create additional folders to
organize your policies.

Administrator Notes: Provide a short description of the policy’s content. This description
displays in ZENworks Control Center.

7 Click Next to display the Puppet Policy page. You can create a puppet policy to run scripts as
either Manifest or Module.

The following options lets you run puppet scripts on a managed device, upload the script file,
and specify if a dry run on the script should be performed.

¢ Run Script As: You can create a policy to run script as either Manifest or Module.

¢ FileName: Depending on your selection to run the script as Manifest or Module, browse for
and upload the script file in the following formats:

Manifest: Upload a .pp file.
Module: Upload a .zip, .tar, .tar.gz, .tar.bz2, .tgz, or .tbz2 file.

NOTE: After creating either Manifest or Module on a Windows operating system, run the
dos2unix command on the puppet script file, to avoid parsing errors on the managed
device.

¢ Dry Run: Select this option to have ZENworks Configuration Management perform a test
to determine if the Puppet policy can be successfully enforced on a managed device.

If there are any issues that could prevent the policy from being enforced, you can view the
issues in the log file created to troubleshoot the policy creation process. The log file is
located at /var/opt/novel1/1og/zenworks/puppet. log. A successful dry run ensures
that the policy can be successfully enforced on the managed device.

¢ Advanced Options: Select this option to specify the Puppet Command Options.

The Run Puppet Command As field displays the puppet command that will be run on the
managed device. The command consists of the following two parts:

Part 1:

Includes the non-editable part of the command as follow:

Creating Linux Configuration Policies 15
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/opt/novell/zenworks/bin/puppet script_name --noop

/opt/novell/zenworks/bin/puppet is the portion of the command that is displayed by
default. Based on your choice to run the script as a manifest or a module, the script_name
parameter is replaced by the name of the manifest file or the module name. If the Dry Run
option is enabled, then --noop string gets appended to the command.

Part 2:

Includes the editable part of the command. The following portion of the command is
displayed by default:

-dv --detailed-exitcodes --confdir /etc/opt/novell/zenworks/puppet -1 /var/
opt/novell/l1og/zenworks/puppet. log

For information on the parameters used in the command, see the following table:

Parameter Description

d Enables full debugging.

% Prints extra information.

detailed-exitcodes Provides transaction information through exit
codes.

| Creates a log file.

log_file_path Path of the log file, the default path is
/var/opt/novell/log/zenworks/
puppet. log.

--confdir Is the Puppet Configuration Directory.

You can choose to edit this portion of the command as in the following examples.
Example 1:

The default log path is /var/opt/novell/1og/zenworks/puppet. log. However, you can
choose to specify a different log file such as a /tmp/puppet.log using the following
command.

/opt/novell/zenworks/bin/puppet script_name --noop -dv --detailed-exit
codes --confdir /etc/opt/novell/zenworks/puppet -1 /tmp/puppet.log

Example 2:

The default puppet configuration file is /etc/opt/novel 1/zenworks/puppet/
puppet.conf. However, you can choose to specify a different configuration file as follows:

/opt/novell/zenworks/bin/puppet script_name --noop --config=/tmp/
mypuppet.conf -1 /tmp/puppet.log

The availability of the supported parameters is dependent on the version of the puppet installed on
the managed device.

8 Review the information on the Summary page and, if necessary, use the Back button to make
changes to the information on the Summary page. In the Summary page the Module file content
displays the list of files that are packaged as either Module or Manifest.

9 (Conditional) Select Create as Sandbox, if you want to create the sandbox version of the policy.
10 Select the check box for Define Additional Properties.
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11 Click Finish to create the new Puppet policy.

12 Click Relationships and assign the newly created Puppet policy to a test device and a non-test
device.
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3.1

Creating Windows Configuration
Policies

Novell ZENworks 11 SP2 Configuration Management lets you create policies by using ZENworks
Control Center or by using the zman command line utility.

The following sections contain step-by-step instructions about creating the Windows Configuration
policies by using ZENworks Control Center:

¢ Section 3.1, “Browser Bookmarks Policy,” on page 19

¢ Section 3.2, “Dynamic Local User Policy,” on page 21

¢ Section 3.3, “Local File Rights Policy,” on page 26

¢ Section 3.4, “Power Management Policy,” on page 29

¢ Section 3.5, “Printer Policy,” on page 31

¢ Section 3.6, “Remote Management Policy,” on page 37

¢ Section 3.7, “Roaming Profile Policy,” on page 37

¢ Section 3.8, “SNMP Policy,” on page 38

¢ Section 3.9, “Windows Group Policy,” on page 40

¢ Section 3.10, “ZENworks Explorer Configuration Policy,” on page 42

The following section explains how to create policies by using the zman command line utility:

¢ Section 3.11, “Creating Policies by Using the zman Command Line Utility,” on page 44

Browser Bookmarks Policy

The Browser Bookmarks policy lets you configure Internet Explorer favorites for Windows devices
and users.

1 In ZENworks Control Center, click the Policies tab.
2 In the Policies list, click New, then click Policy.
or
In the Policy Tasks, click New Policy.
The Select Platform page is displayed.
3 Select Windows, then click Next.
The Select Policy Category page is displayed.
4 Select Windows Configuration Policies, then click Next.
5 Select Browser Bookmarks Policy as the Policy Type, then click Next
6 In the Define Details page fill in the following fields:

Creating Windows Configuration Policies 19



Policy Name: Provide a name for the policy. The policy name must be different than the name of
any other item (group, folder, and so forth) that resides in the same folder. The name you
provide displays in ZENworks Control Center.

Folder: Type the name or browse to and select the ZENworks Control Center folder where you
want the policy to reside. The default is /policies, but you can create additional folders to
organize your policies.

Administrator Notes: Provide a short description of the policy’s content. This description
displays in ZENworks Control Center.

7 Click Next to display the Bookmarks Tree Data Source page.

8 Create a browser bookmarks tree by importing a previously exported file or manually entering
the data. Before you import a book marks file ensure that it is in UTF-8 format. To manually
convert the bookmark file into UTF-8 format, use a text editor

The following list contains browser-specific information to create the exported file:

¢ Internet Explorer 8.x/9.x: In the browser window, click File > Import and Export. Follow the
instructions given in the Import/Export Wizard to create the bookmark.htm file.

¢ Mozilla Firefox 3.x: In the browser window, click Bookmarks > Organize Bookmarks, then
click Import and Backup > Export HTML to create the bookmarks.html file.

* Mozilla Firefox 4.x to 10.x: In the browser window, click Bookmarks > Show All Bookmarks to
open the library. From the toolbar on the library, click Import and Backup > Export Bookmarks
to HTML to create the bookmarks.html file.

9 Click Next to display the Bookmarks Tree Configuration page, then use the options to configure
the bookmarks tree.

The following table lists the tasks you can perform with the New, Edit, and Delete options.

Field Details

New + Click New > Folder to display the Add Folder to Bookmarks dialog box, through which
you can add a new folder to the bookmarks tree.

+ Click New > Bookmark to display the Add Bookmark to Bookmarks dialog box, through
which you can add a new bookmark to the bookmarks tree by specifying the bookmark
name and a URL. Click the button next to the URL field to verify that the URL entered
by you is correct and functional.

Edit + Select the bookmark name you want to change, click Edit > Rename, then specify a
new name.

+ Click Edit > Sort to organize the bookmarks in ascending or descending order.
+ Click Edit > Move Up, Move Down, or Move To to relocate a bookmark.

+ Click Edit > Select All Children > to select all the subdirectories and bookmarks of the
selected parent directory.

+ Click Edit > Deselect All Children > to deselect all the subdirectories and bookmarks of
the selected parent directory.

* Click Edit > Clear Selection > to clear the selections.
Delete + Click Delete to delete the selected bookmarks and the bookmarks folder from the

bookmarks tree. However, you cannot delete the default bookmarks folder named
Bookmarks.

10 Review the information on the Summary page and, if necessary, use the Back button to make
changes to the information on the Summary page.
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3.2

11 (Conditional) Select Create as Sandbox, if you want to create the sandbox version of the policy.

12 Click Finish to create the policy now, or select Define Additional Properties to specify additional
information, such as policy assignment, system requirements, enforcement, status, and which
group the policy is a member of.

Dynamic Local User Policy

The Dynamic Local User policy lets you create new users and manage existing users on the managed
device after they have successfully authenticated to user source.

NOTE:

¢ Itis recommended that you install the latest version of the Novell Client on the managed device
before the Dynamic Local User policy is enforced. To obtain the latest version of Novell Client,
see the Novell Download Web site (http://download.novell.com/index.jsp).

¢ To implement the Dynamic Local User policy without the Novell Client, see Section 3.2.3,
“Implementing the Dynamic Local User Policy Without the Novell Client,” on page 26

1 In ZENworks Control Center, click the Policies tab.
2 In the Policies list, click New, then click Policy.
or
In the Policy Tasks, click New Policy.
The Select Platform page is displayed.
3 Select Windows, then click Next.
The Select Policy Category page is displayed.
4 Select Windows Configuration Policies, then click Next.
5 Select Dynamic Local User Policy as the Policy Type, click Next.
6 In the Define Details page fill in the following fields:

Policy Name: Provide a name for the policy. The policy name must be different than the name of
any other item (group, folder, and so forth) that resides in the same folder. The name you
provide displays in ZENworks Control Center.

Folder: Type the name or browse to the ZENworks Control Center folder where you want the
policy to reside. The default is /policies, but you can create additional folders to organize your
policies.

Administrator Notes: Provide a short description of the policy’s content. This description
displays in ZENworks Control Center.

7 Click Next to display the User Configurations page, then use the options on the page to
configure the user account.

The following table contains information about configuring dynamic local user accounts and
managing them on managed devices:

Field Details
Use User Source Enables logging in through the user source credentials instead of the
Credentials Windows Operating System credentials.
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Field

Details

Use the Credentials
Specified Below (Always
volatile)

Manage Existing User
Account (if any)

Volatile User

Enable Volatile User
Cache

If you do not select Use User Source Credentials, the user account that is
created is always volatile and is not accessible. This setting allows you to
specify the following user credentials for a volatile user:

+ User Name: Specify the user’s name.
+ Full Name: Specify the user’s complete name.

+ Description: Provide any additional information that helps the
administrator to further identify this user account.

+ Use User Source Password: Select this option to create the account
with the password configured in the user source. Ensure that you enable
the setting Manage Existing User Account (if any). If both settings are
enabled, a user who has logged into the workstation at least once, can
login locally on the workstation and access it even in case of network
logon failure.

If a user logs in to a device that has the Dynamic Local User policy applied
and then logs out of the device when the device is disconnected from the
network, the user is unable to log in to the disconnected device again. For
information on this issue, see “Dynamic Local User Policy Troubleshooting” on
page 90.

Helps you to manage a user object that already exists.

If you select both the Volatile User and the Manage Existing User Account (If
Any) check boxes, and the user has a permanent local account that uses the
same username specified in the user source, the permanent account is
changed to a volatile (temporary) account and is removed when the user logs
out.

If a local user object already exists with a DLU user name, any changes to the
DLU user name cannot be applied on the policy unless you enable Manage
Existing User Account (if any). This setting must be enabled for the following
scenarios to work:

+ Manually changing the user password.
+ Changing the user e-directory password.
+ Applying updated settings if the local user account is present on the

device.

Specifies the use of a volatile user account for login. The user account that
NWGINA creates on the local workstation can be either a volatile or a
nonvolatile account.

Enables the caching of the volatile user account on the device for a specified
period of time.

If the Enable Volatile User Cache setting is set in disconnected mode, the
following are possible:

+ On a device that has Novell Client installed, the last logged in user can
log in to the system locally.

+ If you have enabled ZENworks GINA to use DLU without the Novell
Client, then any previously logged in cached user can log in to the
system locally.
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Field Details

Cache Volatile User for  Allows you to specify the number of days to cache the volatile user account on
Time Period (Days) the device. The default value is 5. You can specify a value from 1 to 999 days.

This volatile user account is deleted after the expiry of the specified cache
period when another DLU user logs out from the device.

Not a Member Of Displays the available group to which a user can be assigned as a member.
Member Of Displays groups a user is member of.
Custom Click Custom to display the Custom Group Properties dialog box, through

which you can add a new custom group and configure its rights.

Edit Click Edit to view and edit the details of a custom group. You cannot edit the
default Windows groups with this option.

Delete Click Delete to delete a custom group. You cannot delete the default Windows
groups with this option.

Click Next to display the Login Restrictions page, then fill in the fields to configure user access:

¢ Included / Excluded Users: Lists the users and containers that you want to include or
exclude access to. For more information, see “Rules for Users” on page 25.

¢ Included / Excluded Workstations: Lists the workstations and containers that you want to
include or exclude access to. For more information, see “Rules for Workstations” on
page 24.

The Excluded Workstations List displays the workstations and containers that you want to exclude
DLU access to. Workstations listed or workstations that are in the containers listed here cannot
use DLU access. You can make exceptions for individual workstations by listing them in the
Included Workstations List. This allows DLU access to those workstations only, and excludes DLU
access to the remaining workstations in the container. If the user account is already on the
workstation, the option to exclude the device from receiving the DLU policy is ignored.

Click Next to display the File Rights page.

For a DLU Policy, the timeout duration for enforcing file rights, if it is configured, is 120 seconds.
For large directory structures, the DLU policy might not be enforced because of a time out. To
enforce the file rights, follow instructions in TID 7004171, in the Novell Support Knowledge base
(http://www.novell.com/support/search.do?usemicrosite=true&searchString=7004171).

The following table contains information about managing Dynamic Local User file system
access on the managed device:

Field Details

Add Allows you to select and assign appropriate file rights.

To add a file/folder:
1. Click Add, then specify a file or folder.
2. Select the file rights you want to assign to the specified file or folder.

3. If you want to restrict the inheritance of the rights to only the immediate child file or
folder, select Restrict inheritance to immediate child files/folders only.

4. Click OK.
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Field Details

Edit Copy: Allows you to copy and add a file rights setting to the list.
1. Select a file or folder, then click Edit.
2. Click Copy.
3. Specify a new name.
4. Click OK.
Rename: Allows you to edit only the filename.
1. Select a file or folder, then click Edit.
2. Click Rename.
3. Specify a new filename.
4. Click OK.

Move Up or Allows you to reorder the files or folders.

Move Down 1. Select the check box next to the file or folder you want to move.
2. Click Move Up or Move Down to relocate it.
Remove Allows you to remove a file or a folder from the list.

1. Select the check box next to the file or folder.

2. Click Remove.

Click Next to display the Summary page. Review the information and, if necessary, use the Back
button to make changes to the information on the Summary page.

(Conditional) Select Create as Sandbox, if you want to create the sandbox version of the policy.

Click Finish to create the policy now, or select Define Additional Properties to specify additional
information, such as policy assignment, system requirements, enforcement, status, and which
group the policy is a member of.

3.2.1 Rules for Workstations

Be aware of the following;:

*

*

By default, all workstations are included.

For an indirect association, if an object is in both lists, the closeness of the association is
considered. A direct association is closer than a group association, which in turn is closer than a
folder.

If the closeness is the same, a workstation is directly added to Group A and Group B, and the
Included List takes precedence.

Excluded List Included List Result

Workstation-A Workstation-B The policy is applied on all
workstations except Workstation-
A.
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Excluded List Included List

Result

Workstation Group-1 Workstation-A

Container-1 Workstation Group-1 or
Workstation-A

The policy is not applied on any
workstations in Workstation
Group-1, except for Workstation -
A.

The policy is applied on
workstations that are not
contained in Workstation Group-1.

The policy is not applied on any
workstations in Container-1,
except for Workstation Group-1 or
Workstation-A.

The policy is also applied on
workstations that are not
contained in Container-1.

3.2.2 Rules for Users

Be aware of the following;:

¢ By default, all users are included.

¢ For an indirect association, if an object is in both the lists, the closeness of the association is
considered. A direct association is closer than a group association, which in turn is closer than a

folder.

¢ If the closeness is the same, a user is directly added to Group A and Group B, and the Included

List takes precedence.

Excluded List Included List

Result

User-A User-B

User Group-1 User-A

Container-1 User Group-1 or User-A

The policy is applied on all users
except User-A.

The policy is not applied on any
users in User Group-1, except for
User -A.

The policy is also applied on
users that are not contained in
User Group-1.

The policy is not applied on any
users in Container-1, except for
User Group-1 or User-A.

The policy is also applied on
users that are not contained in
Container-1.
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3.2.3 Implementing the Dynamic Local User Policy Without the Novell Client

To log a dynamic user with an e-directory account into a workstation using the Dynamic Local User
policy:
1 Install the ZENworks Adaptive Agent on the workstation.

2 After successful installation, create a DWORD value Al lowDLUWithoutNovel ICIient under the
following registry key and set its data to 1:

Windows XP (32-bit): HKEY_LOCAL_MACHINEN\SOFTWARE\\Nove I IN\NWG INA

Windows Vista (32-bit and 64-bit):

HKEY_LOCAL_MACH INEN\SOFTWARE\\Novel IN\\Authentication

Windows 7 (32-bit and 64-bit): HKEY_LOCAL_MACHINE\\SOFTWARE\\Novel IN\\Authentication

This support is not available on managed devices running Windows Server operating systems.

NOTE: In Windows Vista or Windows 7, if the initial login screen does not have an option to
enter the username, then do one of the following;:

1. Enable the following setting from the Local Security policy:
a. Launch secpol .msc.
b. Navigate to Security Settings > Local Policies > Security Options.
c. Enable Interactive Logon: > Do not display last user name.
or

2. Create the following registry key
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\Sys
tem] dontdisplaylastusername ?=dword:00000001

For more information on the Registry key see, ZENworks 11 Registry Keys Reference.

3 Create a user source on the ZENworks server, assuming the user source has one user with the
credentials admin/novell.

4 Log in to the workstation using user-source credentials (admin/novell).

A Dynamic Local User account gets created.

IMPORTANT:

¢ If the DLU policy is created to take the credentials other than the user-source credentials, a
DLU user fails to unlock the workstation.

3.3 Local File Rights Policy

The Local File Rights policy allows you to configure rights for files or folders that exist on the NTFS
file systems.
1 In ZENworks Control Center, click the Policies tab.
2 In the Policies list, click New, then click Policy.
or
In the Policy Tasks, click New Policy.
The Select Platform page is displayed.
3 Select Windows, then click Next.
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The Select Policy Category page is displayed.
Select Windows Configuration Policies, then click Next.

5 Select Local File Rights Policy as the Policy Type, then click Next

In the Define Details page fill in the following fields:

Policy Name: Provide a name for the policy. The policy name must be different than the name of
any other item (group, folder, and so forth) that resides in the same folder. The name you
provide displays in ZENworks Control Center.

Folder: Type the name or browse to and select the ZENworks Control Center folder where you
want the policy to reside. The default is /policies, but you can create additional folders to
organize your policies.

Administrator Notes: Provide a short description of the policy’s content. This description
displays in ZENworks Control Center.

Click Next to display the Configure Basic Properties page, then use the options on the page to
configure the attributes.

The following table contains information about configuring a file or folder and the attributes
associated with it:

Field Details

File / Folder Path  Allows you to specify the complete path of a file or folder on the managed device. You
can use the ZENworks system variables or environment variables to specify the path.

To configure system variables in ZENworks Control Center, click the Configuration tab
> the Device Management setting in the Management Zone Settings panel > System
Variables. Click the Help button for details about configuring system variables.

Notify if the file or  When you select this option, a message is sent to the Primary Server. If a folder
folder does not entered by the user is not present on the ZENworks Adaptive Agent, then the policy
exist fails to enforce on the managed device.

If you de-select this option, even if a folder is not present on the ZENworks Adaptive
Agent, a message will not be sent to the Primary Server and the policy will be
enforced successfully on the managed device.

Attributes Allows you to specify the attributes of a file or folder, such as Read only and Hidden.

This page allows you to configure permissions for only one file or folder. If you want to assign
permissions to multiple files or folders, then configure them in the Details page after creating the

policy.
Click Next to display the Configure Permissions page, then use the options on the page to
configure permissions for selected users or groups.

The following table contains information about configuring permissions:
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Field

Details

Permission for
Users or Groups

Create Groups on
the Managed
Device if they Do
not Exist

Remove Access
Control Rules not
Configured by
ZENworks

Inherit Applicable
Access Rights
Configured on
Parent Folders

Allows you to configure permissions for users or groups.

1. Click Add, then Click User or Group to select a user or a group from the
appropriate drop-down list.

2. Select the type of permission you want to configure as Simple NTFS
Permissions or All NTFS Permissions. Depending on the type of permission
you select, a list of permissions are displayed. Configure the permissions as
applicable to the selected user or group.

3. By default, when a permission is set on a folder, all the subfolders and the files
also inherit the permissions. If you want to restrict the inheritance of the rights
to only the immediate child file or folder, select Restrict inheritance to
immediate child files/folders only.

4. Click OK.

The permissions configured for the user or group in the Dynamic Local User policy
takes precedence over the permissions configured in the Local File Rights policy.

Creates a group for which permissions are configured; however the group does not
exist on the managed device. With this option, you can create only local groups.

Removes all access control entries for users or groups not configured by the
ZENworks Local File Rights policy. Also, updates the existing access control entries
for users and groups configured in the policy. After the policy is applied, any manual
changes made to the permissions for a user or group configured by the policy are
lost when the policy is re-applied.

Select Yes if you want a file or folder to inherit applicable access control rules from
its parent object. If you select No, inherited rules are removed. If you do not want to
make any changes, select not configured on the managed device.At least one
attribute, permission, or inheritance setting must be configured to create a policy.
Without configuring any settings, you cannot create a policy.

NOTE: If the Full Control access right is denied for the Administrators or Authenticated Users
group, the policy is successful only during the first enforcement. However, if the Full Control
access right is denied for the Administrators or Authenticated Users group and the Remove access
control rules not configured by ZENworks option is selected, the policy fails.

The unenforcement of the Local File Rights policy from a device fails if the Full Control access
right is denied for the Administrators or Authenticated Users group in the policy.

Click Next to display the Summary page. Review the information and, if necessary, use the Back
button to make changes to the information on the Summary page.

(Conditional) Select Create as Sandbox, if you want to create the sandbox version of the policy.

Click Finish to create the policy now, or select Define Additional Properties to specify additional
information, such as policy assignment, system requirements, enforcement, status, and which
group the policy is a member of.
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3.4

Power Management Policy

The Power Management policy allows you to configure the Power Management settings on the
managed devices by creating a power scheme. It lets you configure the plugged in and battery power
management settings and assign them to a device or a user.
1 In ZENworks Control Center, click the Policies tab.
2 In the Policies list, click New, then click Policy.
or
In the Policy Tasks, click New Policy.
The Select Platform page is displayed.
3 Select Windows, then click Next.
The Select Policy Category page is displayed.
4 Select Windows Configuration Policies, then click Next.
5 Select Power Management Policy as the Policy Type, then click Next.
6 In the Define Details page fill in the following fields:

Policy Name: Provide a name for the policy. The policy name must be different than the name of
any other item (group, folder, and so forth) that resides in the same folder. The name you
provide displays in ZENworks Control Center.

Folder: Type the name or browse to and select the ZENworks Control Center folder where you
want the policy to reside. The default is /policies, but you can create additional folders to
organize your policies.

Administrator Notes: Provide a short description of the policy’s content. This description
displays in ZENworks Control Center.

7 Click Next to configure the power settings for a managed device.
8 In the Add Power Scheme Settings page fill in the following fields:

Scheme Name: The policy name specified on the Define Details page is automatically displayed.
You can either retain the policy name for the scheme or specify a new scheme name. ZENworks
11 creates a scheme with the specified name on the managed device.

Scheme Description: Provide a description for the power scheme. The description is displayed
as a tooltip for the power scheme on the managed device.

Power Settings: To add power scheme settings to a device or user, refer to the following table:

Task Description

Turn off hard disk after How long your hard disk is inactive before the disk turns off.

Slide show The duration for which you want the desktop background slide show to
be active.

Power saving mode The power saving mode for a wireless adapter.

Sleep after How long your computer will be inactive before switching to sleep
mode.

Allow hybrid sleep If your system needs to save work it can, enter a low power state and

resume work immediately.

Enable System Hibernation If system hibernation is enabled or not.
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Task

Description

Hibernate after

Allow wake timer

USB selective suspend setting

Lid close action

Power button action
Sleep button action

Link state

Minimum processor state
System cooling policy
Maximum processor state
Dim display after

Turn off display after
Display brightness
Dimmed display brightness
Enable adaptive brightness
When sharing media

When playing video

JavaScript timer frequency

Critical battery action

Low battery level

Critical battery level

Low battery notification

Low battery action

Reserve battery level

How long your system will be inactive before switching to hibernate
mode.

If timed events should change the state of the computer from sleep
mode to active mode.

If the USB selective suspend feature is turned Off or On.

The action that the computer takes when you close the lid of your
mobile-PC.

The action to be taken when you press the Power button.
The action to be taken when you press the Sleep button.

The Active State Power Management mode to be used for PCI
Express-based serial links when the links are idle or less active.

The minimum performance state of your processor.

The cooling mode for your system.

The maximum performance state of your processor.

How long your system is inactive before the display dims.
How long your system is inactive before the display turns off.
The normal brightness level of your system.

The display brightness when your monitor display is dimmed.
If your monitor supports adaptive brightness.

What your computer does when sharing media files.

The power optimization mode used by your computer's video
playback pipeline.

The power optimization mode used by your computer for Internet
Explorer 9 and Internet Explorer 10 browsers.

The action that your computer takes when the battery reaches the
critical level.

The percentage of battery capacity remaining that initiates the low
battery action.

The percentage of battery capacity remaining that initiates the critical
battery action.

Whether a notification is shown when the battery capacity reaches the
low level.

The action that your computer takes when battery capacity reaches
the low level.

The percentage of battery capacity remaining that initiates reserve
power action.
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NOTE:

. We recommend that you configure the power scheme duration in the following
descending order: System Hibernation > System Standby > Hard Disks > Monitor.

. The values of System Standby and System Hibernation are interdependent. If you
choose to set the state of these settings to Not Configured, in such a case, the other setting can
only be set to either Never or Not Configured. This is to ensure that the 'Standby Timeout' is
always lesser than the 'Hibernate Timeout'.

For example, if you set a duration for the System Standby value and then set the System
Hibernation value to Not Configured, the System Standby value automatically changes to
Not Configured.

¢ When you apply power management settings on a Windows XP managed device, the
scheme name is displayed in the settings panel of the Windows Power Options console only
for a system user.

3.5 Printer Policy

The Printer policy allows you to configure Local, SMB, HTTP, TCP/IP, CUPS, and iPrint printers on a
Windows device.
1 In ZENworks Control Center, click the Policies tab.
2 In the Policies list, click New, then click Policy.
or
In the Policy Tasks, click New Policy.
The Select Platform page is displayed.
3 Select Windows, then click Next.
The Select Policy Category page is displayed.
4 Select Windows Configuration Policies, then click Next.
5 Select Printer Policy as the Policy Type, then click Next.
6 In the Define Details page fill in the following fields:

Policy Name: Provide a name for the policy. The policy name must be different than the name of
any other item (group, folder, and so forth) that resides in the same folder. The name you
provide displays in ZENworks Control Center.

Folder: Type the name or browse to and select the ZENworks Control Center folder where you
want the policy to reside. The default is /policies, but you can create additional folders to
organize your policies.

Administrator Notes: Provide a short description of the policy’s content. This description
displays in ZENworks Control Center.

7 Click Next to display the Printer Identification page, then select the type of printer to be installed
on the managed device.

8 Click Next, then skip to the appropriate step, depending on which printer type you chose in
Step 7:

¢ Local Printer: Continue with Step 9.
¢ Network Printer: Skip to Step 10.
¢ iPrint Printer: Skip to Step 11.
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NOTE: Create and assign separate policies for different platforms for a printer.

9 (Conditional) If you are configuring a local printer, refer to the following table for more
information:

Field Details

Name Specify the name of the local printer that you want to configure on the target
device.

Driver Browse to and select a suitable driver for the printer. If the driver is not contained
in the browser list, type in the correct model nhame. The driver must either be
installed on the target device or specified in the enforced policies. The driver
must be digitally signed by Microsoft. However, if you choose to use a driver that
is not digitally signed, see the Troubleshooting Scenario.

Port Select the physical port to which the printer is added, such as LPT1, COM1 or
Standard TCP/IP.

NOTE: If you assign a TCP/IP Printer policy to a 11 SP1 or older version of the
agent, the policy gets applied and then fails and sends errors to the server at
every refresh, as it is not supported.

Remove the association with the lower version of the agents from the TCP/IP
printer policy, to prevent it from being applied at every refresh.

IP Address Specify the IP address of the local printer. This field appears only if you select
Standard TCP/IP as the port.

Protocol Specify the protocol of the local printer. You can select either RAW or LPR from
the drop-down options. This field appears only if you select Standard TCP/IP as
the port.

Port Number Specify the port number for the protocol. Typically the port number is 9100. This
field appears only if you select the RAW protocol on the Standard TCP/IP
settings page.

Queue Name Specify the queue name to be used by this port, if a name is required by your
printer. This field appears only if you select the LPR protocol on the Standard
TCP/IP settings page.

LPR Byte Counting Choose this option if you encounter problems such as missing or incomplete

Enabled documents when printing. When LPR byte counting is enabled, the system
counts the number of bytes in a document before processing the print request.
Most printers do not need byte counting enabled because it can be very time
consuming. This field appears only if you select the LPR protocol on the
Standard TCP/IP settings page.

SNMP Status Enabled Select this option if the printer attached to this port supports RFC1759. This field
appears only if you select Standard TCP/IP as the port.

Community Name: Specify a community name, for example: public.

SNMP Device Index: Specify the device index, for example: 1.

ZENworks 11 Configuration Policies Reference
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Field

Details

Install a Driver

Model Name

Driver File Path

Supported Platforms

Language of
Installation

Install Forcefully Even
if the Driver is Already
Installed

Select this option to install a driver on the target device. The driver installation
must be non-interactive and silent. The supported driver installation type is - inf
and the . inf driver files can be bundled in .zip or .tar formats. The . inf
file can be specified directly if it is already available on the target device. Ensure
that the . inf file supports the installation of the driver.

NOTE: To add a new printer driver to the existing driver list:

Edit the

zenworks_instal ldir\novel I\zenworks\share\tomcat\webapps\ze
nworks\WEB- INF\conf\printerDriverDetails.conf file to add the
following line:

Printer_ Manufacturername = Printer_ Model

For example, if you want to add an HP Color LaserJet 4550 PCL printer, then
add the following line:

HP = HP Color LaserJet 4550 PCL
Browse to select the model name of the driver.

Specify the driver files either from a particular device where the browser is
running or from a path on the managed device, such as C:\temp\nipp.zip.

NOTE: While configuring the policy, if you are using a UNC path to access the
Driver file, make sure the file you access must be on an anonymous share.

Specify a platform for the driver. The platform information helps to select a
suitable driver from the available drivers list, which is based on the installation
platform.

Select the installation language. Your choices are English (United States),
French, German, Portuguese, Spanish, Italian, Chinese (Traditional), Chinese
(Simplified), or Japanese.

Select this option to force installation of the driver, even though it is already
installed on the target device.

(Conditional) If you are configuring a Network printer, refer to the following table for more

information:

Field

Details

Name / Location

Driver

Specify the UNC path or URL name of the HTTP, SMB or CUPS printer.

For example, it is \\server-name\printer-name for an SMB printer,
http://server:631/printers/myprinter for a CUPS printer, or http://
server/printers/._myprinter/._printer for a HTTP printer.

NOTE: Support for network printer that prompts for user credentials is not
provided.

Browse to add and select a suitable driver for the Windows HTTP printer. You can
ignore this for SMB printers.

The driver must be digitally signed by Microsoft. However, if you choose to use a
driver that is not digitally signed, see the Troubleshooting Scenario
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Field Details

Install a Driver Use this option to install a driver on the target device. The driver installation is
non-interactive and silent. The supported driver installation types is . inT and the
- inf driver files can be bundled in .zip or .tar formats. The . inf file can be
specified directly if it is already available on the target device. Ensure that the
- inF file supports the installation of the driver.

NOTE: To add a new printer driver to the existing driver list:

Edit the

zenworks_installdir\novel I\zenworks\share\tomcat\webapps\ze
nworks\WEB- INF\conf\printerDriverDetails.conf fileto add the
following line:

Printer_ Manufacturername = Printer_ Model

For example, if you want to add an HP Color LaserJet 4550 PCL printer, then add
the following line:

HP = HP Color LaserJet 4550 PCL
Model Name Browse to select the model name of the driver.

Driver File Path Specify the driver files either from a particular device where the browser is running
or from a path in the managed device, such as c:\temp\nip.zip.

NOTE: While configuring the policy, if you are using a UNC path to access the
Driver file, make sure the file you access must be on an anonymous share.

Supported Platforms  Specify a platform for the driver. The platform information helps to select a
suitable driver from the available drivers list, which is based on the installation

platform.
Language of Select the installation language. Your choices are English (United States), French,
Installation German, Portugese, Spanish, Italian, Chinese (Traditional), Chinese (Simplified),

or Japanese.

Install Forcefully Even Select this option to force the installation of the driver on the device every time the
if the Driver is Already policy is applied on the device, even if the driver is already installed on the device.
Installed

11 (Conditional) If you are configuring an iPrint printer, refer to the following table for more
information:

On Windows Vista devices, you need to install the Novell iPrint client 5.04 or later.

Field Details

Name / Location Specify the URI name of the iPrint printer. For example, ipp://acme.com/
ipp/servername.

Update iPrint Printer Select this option to update the printer driver and to reinstall the printer driver

while Installing the Driver from the iPrint server while installing the iPrint printer.

ZENworks 11 Configuration Policies Reference
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Field

Details

Install iPrint Client

iPrint Client Installer File
Path

Install Forcefully Even if
the Driver is Already
Installed

Configure iPrint Client

Proxy Server

Select this option to install the iPrint client on a target machine. The iPrint client
is not supported on 64-bit versions of Windows Server 2003.

The installation file can be either nipp.zip or nipp-s.exe, both of which are
capable of carrying out non-interactive silent installation.These files can be
uploaded from the machine where the browser is running.

To install the iPrint client, you cannot use a -exe file that does not support a
silent installation. For example, you cannot use a nipp.-exe file to install iPrint
client.

Allows to specify the path to the iPrint Client Installer (which installs the iPrint
client on the managed device).

+ On the Managed Device: Select this option to specify the path to the
iPrint client installer on the managed device.

+ Select from this Device: Select this option to add the iPrint client
installer as content with the policy. You can also distribute the iPrint client
installer along with the policy.

If the installer file path is a UNC path, the Novell iPrint Client dialog box is
displayed until the installation process completes. This process can be
perfomed only by users with administrative rights.

Select this option to force installation of the driver, even though it is already
installed on the target device.

Select this option to configure the iPrint proxy server.

If the workstations are located outside the physical firewall, you can use this
option to specify the proxy address followed by a (:) and the port number.

Specify the iPrint proxy server name. For example, http://
proxy .companyx.com:8080

Click Next to display the Printing Preferences page, then use the options to specify the
preferences. Refer to the following table for more information:

Field Details

Orientation Select this option to specify the paper layout for the printer, such as landscape or
portrait.

Duplex Printing Specify whether or not to print on both sides of the paper, if the printer has that
capability.

Collate Specify whether or not the printer should organize multiple copies of a document,

if the printer has that capability.

Print Quality Select the print quality. Select High quality, for the best possible resolution, or
select Low quality for lower resolution and lower quality.

Creating Windows Configuration Policies
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Field Details

Paper Source Specify the paper source for the printer. A source that is not listed in the standard
available list can also be specified, but it must be supported by the printer.
Information on supported paper sources is available in the printer documentation
or in the registry key
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\Print\Printers\printer-
name\DsDriver\printBinNames on a Windows machine.

Paper Size Specify the paper size for the printer. You can specify any paper size supported by
the printer, in addition to the options listed in the menu. Information on supported
sizes is available in the printer documentation or in the registry key
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\Print\Printers\printer-
name\DsDriver\printMediaSupported on a Windows machine, where a
printer is locally installed.

13 Click Next to display the Additional Printer Policy settings, then use the options to specify the
settings. Refer to the following table for more information:

Field Details
Set as Default Select this option to specify a printer as the default printer to which the print
Printer requests are sent if no other printer is specified by the user.

On a Windows 7 managed device, the assigned printer might be set as a default
printer on the device even if the Set as Default Printer option is not selected in the

policy.

Remove all Printers  Select this option to remove all printers that are not specified through the ZENworks
not Specified by Printer policy.

ZENworks Printer

Policies

14 Click Next to display the Summary page. Review the information and, if necessary, use the Back
button to make changes to the information on the Summary page.

This wizard allows you to configure only one printer. If you want to configure additional
printers, then configure them in the Details page after creating the policy.

15 (Conditional) Select Create as Sandbox, if you want to create the sandbox version of the policy.

16 Click Finish to create the policy now, or select Define Additional Properties to specify additional
information, such as policy assignment, system requirements, enforcement, status, and which
group the policy is a member of.

Only the preferences that are supported by the printer are configured on that printer.

NOTE: Upon unenforcement of a user-assigned printer, a user with administrative privileges
continues to have access to the local printer on a Windows XP mana